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Outlook Emails on Desktop App – Basics 
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Glossary 
OneDrive: this is Microsoft’s own storage in the Cloud. It works in the background of Office 
365 and is your personal storage space. It is secure and cannot be accessed by others.  

Cloud: in simple terms, the Cloud is the internet. It's all of the things you can access 
remotely over the Internet, such as data and programmes. When something is in the cloud, 
it means it's stored on special internet computers (called ‘servers’) instead of solely on your 
computer. 

Online: when you are connected to the internet. 

Application: the different programmes within O365 are called applications, e.g. Outlook, 
Word, PowerPoint, Teams. Often shortened to App(s). 

Icon: the ‘logos’ of the different applications (e.g. Word is a blue W, Excel is a green E, 
OneDrive is a blue cloud) or web browsers (e.g. Chrome is a coloured circle) 

Desktop apps: applications that are available on your laptop/computer by clicking onto the 
icon. They may be on your bottom taskbar, or in your Start menu. You don’t have to be 
online to see and access them.  

Window: In computer terms, a window is an area on the screen that displays information 
about a programme. You can have multiple windows open, displaying different websites, 
documents and applications. 

File Explorer: the ‘folder’ icon that displays along your bottom taskbar; the one you have 
been using to find your documents, downloads, pictures and desktop. 

Web location: this is where something is on the internet (including the Cloud).  

Hyperlink: this is a link that can be put into an email, a document, web page or a meeting 
invite that takes you to another document or page. Words on a website or in a document 
that are blue and underlined that you can click on in order to open a new web page are an 
example of a hyperlink. 
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Opening Outlook 
For Outlook desktop application, you should either have it as a shortcut on your computer 
desktop  

 

or on your taskbar along the bottom of your screen 

or you can find it via Start menu. 

 

 

 

 

 

Email – the Home tab 

 

The Home ribbon along the top of Outlook includes groups called New, Delete, Respond,  
Find, Speech. 

The main one you will likely use is New Email. 

Sending ‘New Email’ 
The New group has ‘New email’ and ‘New items’. (A new item is anything other than an 
email – such as an appointment, meeting, contact or task.) 

Clicking on ‘New email’ opens a blank email draft ready for you to type into.  
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To and CC: 
You can click on ‘To’ and ‘CC’ and use ‘Add Recipients’ to find the person you wish to email, 
or you can start typing a name into the To/ CC fields and Outlook gives you suggestions. 

BCC: 
To access BCC (which is ‘blind carbon copy’), you need to click onto the CC field and a box 
opens within global address list which includes a BCC field option at the bottom.  

 

 

 

 

 

 

 

 

 

 

 

You should use BCC to add an email address that should not be seen by other recipients in 
the email. It is common practice to use the BCC field when emailing a very long list of people 
or a list of recipients who may not know each other. This is particularly important when 
sending to people using their personal email addresses.  

TIP: to send a message to multiple people when none of them know the other recipients, 
you can send the message to yourself and put all the recipients in BCC field. 

 

Along the top ribbon of the ‘new email’ draft are some tabs. These tabs are arranged 
according to function: Message, Insert, Draw, Options, Formal Text, Review, Help.  

 
Message tab 

 

The Message tab includes the groups called Include, Tags, Voice, and Immersive. 
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Include group – attaching files 
This is an important group because you can choose to attach a document, insert a link into 
your email or include a signature.  

  

Attach files 

Click onto the dropdown arrow and you get the option of ‘Attach Item’, ‘Browse Web 
Location’ or ‘Browse this PC’. It will also display your most recently opened files to try to 
help you find what you want.  

 

 

What do these each mean?  

Attach item – lets you attach an Outlook email.  

Browse this PC – allows you to attach a document straight from your computer’s 
desktop if you have it saved ‘locally’. This will be a copy of the document, not the live 
document itself.  

Browse web locations – allows you to share documents online. Click onto OneDrive 
and it will open a list of your OneDrive files and folders via your File Explorer area. 

 

 

 

 

 

 

Click against the document you want to attach, then click ‘Insert’. 
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You will be asked how you want to attach: share link or attach as copy. 

 

 

What is the difference?  

Attach as a copy takes up space on your email because it attaches a physical copy to 
it. (Current Outlook limit for file size is 20mb.) 

This is a copy, NOT a live version so it’s important to remember that this means each 
recipient gets their ‘own’ copy and, therefore, would return their own copy if you need 
them to change or add things so you may have to transfer amendments across to your own 
copy. 

 

  Share link takes up no space on your email because it simply attaches the link to 
your live document. This way, your recipients can collaborate on it in real time.  

To clarify, sharing as a link displays your attachment with a cloud icon – 

  

 

Once you have chosen ‘share link’, you can use the drop-down box to change access 
permissions before you send the email. The default is ‘organisation can edit’ so make sure 
this is what you want. If not, choose from anyone can view, organisation can edit or view, 
recipients can edit or view. 

 

 

 

 

 

 

For example, choose ‘recipients can edit’ and the permission under the document name will 
change: 

 

 

As you can see in the dropdown list, you can also easily switch to ‘Attach as Copy’ if you 
change your mind and want to send a physical copy. 
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Link 

To insert a hyperlink into the body of your email, click onto ‘Link’ from the ‘Include’ group 
and choose from the list of recent document displayed. If it is not there, click onto ‘Insert 
Link’ at the bottom and use the dialogue box to find the document you want to insert the 
link for. You may have to use the ‘up one folder’ icon to navigate around to find your 
document.  

 

 

 

 

 

 

Once you have found your document, click OK and the link to it will be inserted into your 
email in a link like this: 

 

If you need to set permissions for access, just click onto the link and it will display the 
default setting of ‘People in your organisation with the link can edit’. Remember that this 
includes anyone internal to whom the link was forwarded without your knowledge, which 
may not be what you want to happen. 

 

To change this, click on the arrow next to it and a ‘Link Settings’ box will appear. These 
options are the same as your OneDrive sharing permissions, except ‘Recipients of this 
message’ which only appears via this Outlook email sharing route. 
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Options tab 
The Options tab of a new email allows you encrypt your email, request a delivery receipt 
and request a read receipt.  

 

Encrypt 
 

 

 

 

 

 

This has some encryption options but you should only use Encrypt Only.  

Please read the Barnardo’s Encryption guide for more in-depth instructions for encrypting 
emails within the organisation.  

https://inside.barnardos.org.uk/resources-and-guidance/our-it/software-and-
systems/encrypting-emails  
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The Delete group on Home tab 
 

 

 

Apart from Clean Up, the Delete group is mainly self-explanatory. Just bear in mind that if 
you click onto Delete or Archive, your selected email will be moved straightaway – there is 
no ‘are you sure’ message. However, if you do move anything accidentally, it is easy to get 
back – just find it in the Delete/Archive folder and drag it back into Inbox. 

 
Clean-Up 
One useful feature in this Delete group is the Clean-Up command. The Conversation Clean 
Up feature in Outlook can reduce the number of messages in your mail folders. Redundant 
messages throughout a conversation are moved to the Deleted Items folder. 

  

A ‘conversation’ is also known as an email trail or thread and is the complete set of email 
messages from the first message and all following responses. The messages of a 
Conversation have the same subject. 

Clean Up evaluates the contents of each message in each Conversation. If a message is 
completely included within one of the replies, the previous message is deleted.  

With ‘clean up folder’, all conversations in the selected folder are reviewed and redundant 
messages are deleted. If you choose ‘Clean Up Folder & Subfolders’, the same happens to all 
conversations in the selected folder and any folder that it contains. Or you can do ‘Clean up 
Conversation’ when you are clicked onto an email in a particular trail.  

You don't have to worry about lost details because Outlook looks at the content of emails 
and deletes earlier messages that have duplicate content but will not delete messages with 
attachments. 

For full details and guidance on the Clean-up tool, please see the guide on Inside Barnardo’s. 

https://inside.barnardos.org.uk/outlook-training-and-guidance 
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The Tags group on Home tab 

 

 
Follow-up 
Use this to set flags to remind you of an email that has something in it to complete, or that 
you want to get back to later.  

Follow-up is also on your  

 

 

 

 

 

 

 

 

You can also set a reminder that comes up like a calendar reminder and can also set an 
accompanying sound alert. You can flag for follow-up, forwarding, read, or reply.  
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The Speech group on Home tab 
This is the ‘Read Aloud’ feature that is found across Office 365. Clicking onto this command 
brings up a small toolbar with controls to start, pause, rewind and forward. In the settings, 
you can change the voice and reading speed.  

  

The ‘Read Aloud’ feature is also found in the group of commands called ‘Immersive’ when 
you reply to an email.  

 

The View tab 

 

The View tab is where you find your settings for how your Outlook email screen is laid out 
and can switch to Focused Inbox.  

Change view 

You can use the ‘Change View’ command to change how your email list looks and if you 
want a reading pane or not. A reading pane is the area to the right that shows the contents 
of the email you are currently clicked onto 

Use ‘ current view’ to switch to a different view type.  Choose compact or single to keep a 
reading pane, or preview without one. If you are not sure, try each to see what you prefer. 
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‘Focused inbox’ group 
Focused Inbox separates your inbox into two tabs—Focused and Other. Your most 
important email messages are on the Focused tab while the rest remain easily accessible but 
out of the way on the Other tab.  

Click onto ‘Focused inbox’ command and the Focused and Other tabs will appear at the top 
of your mailbox. You’ll be informed about email flowing to Other, and you can switch 
between tabs any time to take a quick look. 

At Barnardo’s, the Others tend to be emails from Workplace or other systems. However, 
you can change how your messages are organised between the two tabs.  

1. From your inbox, select the Focused or Other tab, and then right-click the message 
you want to move. 

2. If you're moving from Focused to Other, select ‘Move to Other’ if you want only the 
selected message moved. Select ‘Always Move to Other’ if you want all future 
messages from the sender to be delivered to the Other tab. 

3. If you're moving from Other to Focused, select ‘Move to Focused’ if you want only 
the selected message moved. Select ‘Always Move to Focused’ if you want all future 
messages from the sender to be delivered to the Focused tab. 
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Receiving your Emails 
Once you click on and open an email you have received, you will get a list of commands 
under the Message tab along the top of the opened email. 

 

 

 

 

 

The Delete group 

 

Delete and Archive: 

Choosing one of these will immediately move the email into the Delete or Archive folder; it 
does not ask ‘are you sure’. If you move an email by accident, don’t panic- just go into the 
‘delete’ or ‘archive’ folder, find the email you moved in error, and drag it back into the 
inbox.  

For Archive, there is actually no difference in the retention period of emails either within 
the Archive folder or Inbox (including subfolders); there is a default 2yr retention period 
across all emails in a user’s mailbox. 

 

The Respond group 
 

 

 

Your Reply, Replay All and Forward options are all also found on your opened email in the 
top right corner.  

 

 

 

But using this ‘Respond’ group, you can also reply with a meeting or reply with an IM 
(instant message). 

Or choose ‘More respond actions’ which include forwarding it as an attachment and calling 
the sender.   

 

 



14 
Outlook Desktop App Basics Guide V1 Nov 2021 

‘Tags’ group 

 

Follow-up 

Use this to set flags to remind you of an email that has something in it to complete. Or that 
you want to get back to later.  

See page 10 for details of Follow-up as it is the same for sending, receiving and replying to 
emails. 

 

 

The Editing group 
 

 

 

This is where you can use:  

 ‘Find’ to search for a word in an email trail  
 ‘Related’ to find all messages within the same conversation or from that sender 
 ‘Select ‘to highlight and select everything within the email trail.  
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Receiving an email that has a shared document 
If a document is shared with you, you can see it a couple of ways depending on the method 
the sharer has used.  

Shared as an attachment link 
You get an email that says the name of the file and who has shared it with you. You can 
either click on the actual document icon (e.g. TTP Plan in the example) or on the ‘Open’ 
button to access the document.  

Just remember that this takes you to the live document, not a copy.  

 

 

 

 

 

 

 

Please don’t be nervous about opening and potentially working on someone else’s live 
document – they have deliberately given you access to do this. OneDrive has Version History 
built in, so if you accidentally type over something, you or your colleague can revert to a 
previous version (see OneDrive Guide for further information). 

When you go into the shared document, the sender will be informed by email that you have 
done so. If you make changes, the sender gets told this and can go into the document to 
look at your comments or changes.  

 

By a link in the email body 
Some people prefer to share access to their document via a link that is within the email text, 
instead of as a shared document attachment. If this is the case, just click onto the link and 
you will be taken to the live document.  

  

 

 

 

 

 

 

 


